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Terminologies 

 

Software - Is a set of instructions, data or programs used to operate computers and 

execute specific tasks. E.g., CMMS 

Customization – In the context of software is the action of modifying something to 

suit an individual or task. 

User Accounts - A user account is an identity created for a person in a computer or 

computing system. It’s comprised of a username, password and any information 

related to the user. 

Field - A field in computing is a user interface element designed for entering data. 

Many software applications include fields that allow you to provide input using your 

keyboard. 

Browser - A web browser (commonly referred to as a browser) is a software 

application for accessing information on the World Wide Web. When a user requests 

a web page from a website, the web browser retrieves the necessary content from 

a web server and then displays the page on the user's device. 

Website - A set of related web pages located under a single domain name (URL), 

typically produced by a single person or organization. 

Homepage - The main web page of a website. The term may also refer to the start 

page shown in a web browser when the application first opens. 

Open Source - A software for which the original source code is made freely available 

and may be redistributed and modified according to the requirement of the user. 
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Acronyms 

CMMS – Computerized Maintenance Management System 

MoHS – Ministry of Health and Sanitation 

PM - Preventive Maintenance 

CM - Corrective Maintenance   

URL - Uniform Resource Locator  
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1.0 Introduction and Overview of CMMS 

 

This section gives an overview of the software used by the Maintenance staff, its 

features, importance, and the reasons for selecting it among many other software 

products that can be used by Hospitals Maintenance units.  

1.1 Background of CMMS 

Maintenance activities has been viewed as a “cost centre” where too much money 

goes with little measurable return. Management is beginning to realize that 

maintenance offers real opportunities in reducing cost and increase productivity.   

Maintenance can account for as much as 60% of controllable and substantially reduced 

equipment operating costs. The most important factors to consider for an electronic 

system for maintenance relate to reduce cost, but also consider such results as better 

organizational methods, reduced paperwork, and improved reporting and 

communications.  

1.2 About the Software - CMMS 

Computerized Maintenance Management Systems (CMMS) is a tool that can help 

automate maintenance management (plan preventive and corrective maintenance) to 

increase overall equipment efficiency.  

It helps to standardize data with the ability to run useful reports. It gives a realistic 

picture of the hospital maintenance activities and assist staff in maintenance planning.  

CMMS is a customisation of the workflows adopted from Odoo Maintenance module 

for use by Maintenance unit staff at all Hospitals and DHMTs in Sierra Leone. 

Odoo is an open-source software which required high cost of license fee if all its 

features are to be utilized.  

CMMS is developed using dotnet core and Microsoft SQL Server technology from 

scratch uniting Odoo workflows aligned with the country maintenance processes.  
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The information included in the CMMS is the: 

• medical equipment inventory  

• service history 

• preventive maintenance procedures 

• equipment and staff performance indicators 

• Spare parts and costing information and reporting. 

1.3 Features of CMMS 

• Customisation of the CMMS to the country's maintenance units needs 

• Facilitate equipment and infrastructure data collection and regular updating 

(asset inventory) in Hospitals and health facilities  

• Standardization of data collected (allowable entries for equipment’s, preventive 

and corrective maintenance activities, technicians’ profile).  

• One-time entry of each equipment 

• Ability to track equipment’s and spare parts supplies/donations 

• Ability to run reports as specified by the hospital management or other key 

stakeholders  

• Institutionalize maintenance services documentation and reporting 

• Automatic scheduling and email alerting for maintenance tasks  

• Set up a system/network for maintenance and management of health physical 

assets involving MOHS and the health facilities 

1.4 Importance of the CMMS 

• Easy to update and manage inventory 

 Better management of health physical assets; maintenance scheduling, 

improve uptime, efficient use of manpower and time resources, 

monitoring real time status of assets. 
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 monitor equipment performance indicators such as mean time between 

failures, down time, and maintenance costs for equipment of the same 

model, type, or manufacturer. 

 monitor staff performance indicators such as repeated repairs by the 

same staff member for the same problem, average down time associated 

with individuals, and productive work time.  

 standardize and harmonize Inventory data / information. 

• Evidence-based decision making in maintenance and management 

• Maintenance activities reporting will be a breeze. Reports can be generated to: 

 plan user training programmes based on equipment failure trends in certain 

departments or health facilities. 

 assist in the monitoring and improvement of the productivity, effectiveness, 

and performance of hospitals staff. 

1.5 Composition of the CMMS users and their roles 

MOHS ICT/DPPI/HSS or MOHS Asset Office In-charge – CMMS Administrator 

• Manage users and the CMMS software,  

• Controls users accounts for the system as necessary 

• Maintains and manages system documentation 

Maintenance Heads/Hospital Secretary/M & E/DHMT 

• Register/update Asset Register at facility level 

• Log maintenance request from Hospital/PHU staff 

• Complete the Work order form for equipment maintenance 

and track progress  

• Maintain a list of all maintenance staff with their 

skills/professional background 

• Request user access for maintenance staff from their 

facility to CMMS Admins 

• Generate monthly/quarterly reports as requested by 

Management. 
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Maintenance Technicians 

• Received job order 

• Prepare job order progress report and submit to the 

maintenance head 

 

SCBU In charges / Pediatricians 

• Submits maintenance request to technicians 

• Monitor progress of request 

 

 

 

Partners 

• Support CMMS development/upgrade, deployment, 

and use. 

• Hospitals Equipment Inventory and maintenance data 

sharing/access 
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1.6 CMMS Information Flow 

 

1.7 CMMS Infrastructure/Network concept 
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1.8 CMMS Workflow  
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2.0 Accessing CMMS  

 

To launch the CMMS application, users need to: 

• Connect to the internet 

• Locate a Browser (Chrome, Firefox, Microsoft Edge etc.) on a mobile 

device (smart phone, tablet), or a laptop/Personal computer and double click 

it. 

 

 

 

 

 

 

 

 

• Enter the CMMS Uniform Resource Locator (URL) in the address bar. Press the 

Enter key on the keyboard or Click Go 

 

 

 

 

 

 

 

 

 

• The browser will take the user directly to the login page 

 

 

Enter www.cmms.sl 

and press the Enter Key  

Step 1: Enter Username 

http://www.cmms.sl/
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2.1 Login page  

The login page is the same for all users accessing the CMMS application. 

In the login page, users can view and download the  

 CMMS user manual 

 a brief background on CMMS (About CMMS) 

To login to CMMS 

Step 1: Enter the username provided to you by the CMMS 

Administration/Admin_Staff. 

Step 2: Enter the Password given to you 

Step 3: Click the Sign In button 

 

  

 

 

 

 

 

 

 

In most cases, the browser popup will ask if a user want to save the password as 

shown in the dialog box below, 

❑ Click Never. This prevents storing the username and password on the 

browser. 

This will prevent other users using the same laptop to automatically Sign In to your 

account with your username and password. 

 

 

 

Step 1: Enter Username (email) 

Step 2: Enter Password 

Step 3: Click Sign In 

CMMS user manual/flyer can be 

downloaded by clicking the link 

Click “Never” 

Save Password  
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When you log in successfully as an authorised user, the content you have access to 

will vary depending on the rights and privileges given to you by the CMMS 

Administrator 

2.2 Change Password  

All users are required to change their passwords given to them by the CMMS 

Administrator after they successfully sign-in for the first time.  

To Change Password 

Step 1: Click the Profile name on the top right.  

Step 2: Select Change Password  

 

In the Change Password dialog box 

Step 1: Enter Old Password given to you by the CMMS administrator.  

Step 2: Enter New Password  

Step 3: Confirm New Password  

Step 4: Click Submit  

Note: Use a combination of Uppercase and Lowercase letters, Numbers, and Special 

characters for strong passwords (8 Characters minimum). 

 

 

 

 

 

 

 

Step 1: Click the Profile Name 

Step 2: Click Change Password 

Step 1: Enter Old Password 

Step 2: Enter New Password 

Step 3: Confirm New Password 

Step 4: Click Submit 
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3.0 CMMS Administration Overview 

 

Administering CMMS can be done by the Admin_Staff at facility level and the 

designated CMMS administrator at central level (MOHS/DPPI). The role will involve: 

• Creating user accounts and assigning role to maintenance staff. 

• Changing configurations and editing fields in the modules  

When you login as an administrator, you have access to the:  

• Settings Module – Used to add/edit Health Facilities (Hospitals and DHMTs), 

Users, and roles,  

• Maintenance Module – Setting Configurations for Maintenance module use 

for Inventory management, Maintenance Request, Spare Parts, Scheduling and 

Reporting.  

To access the Setting Module, Click on Setting from the home page as shown below. 

3.1 Settings Module 

Below is the interface for the Settings module 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Add Hospitals/DHMTs to CMMS 

 
Create a new user 

 

Click to go back to Homepage 

ile 

Create Users & Roles 

Download Technician profile 

 

Users created on CMMS 

Delete a User 

Edit Users profile 

Reset Users Password – 

Default password - 123 
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3.1.1 Creating Hospitals/DHMTs 

To create/add a hospital to CMMS 

Step 1: Select the Hospitals tab.  

Step 2: Click Create  

 

 

 

 

In the Add Hospital form 

Step 1: Enter the Hospital/DHMT Information (name, Address, Phone Number 

and Email of Designated head/contact person).  

Step 2: Click Submit to Save  

 

 

 

 

 

 Step 1: Select the Hospitals tab 

Step 2: Click 

Create  

 

Step 2: Click Submit 

Step 1: Enter Hospital/ 

DHMT Information 
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3.1.2 Navigating, Creating Roles and Permissions 

To open the roles form, Select Roles from the Users & Roles dropdown menu 

  

3.1.3 Role Permission (E.g., Role: Admin) 

The Role Permission define which module a role/user can access. 

To Edit a Role Permission, Select the Edit button highlighted in step 4 above. 

The Role Permission form will display as shown below. 

• Select/Tick from the list of modules you want the selected role to View, 

Create, Edit and Delete data from.  

• Click Save to update permission changes 

 
 

 
 

 

 

 

 

 

 

 

  

Roles Permission  

Modules  

 

 

 

Step 1: Select Roles from 

the Users & Roles 

dropdown and click Roles 

Step 4: Click Edit to modify Permissions for a Role 

 

Step 5: Click Delete to remove a Role 

Step 3: Click Edit to modify a Role 

name

Step 2: Click Create to 

add a new Role 
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3.1.4 Creating Users 

To create users,  

Step 1: Select Users from the Users & Roles dropdown menu  

Step 2: Click Create  

 

 

 

 

 

In the Add User form, complete the fields for user’s information as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1: Select Users from the 

Users & Roles dropdown  

Step 2: Click 

Create to add a 

new User 

Step 2: Enter a 

temporary Password 

for user (minimum 6 

characters) 

Step 6: Select a Default 

Hospital for user 

Step 3: Click 

to upload a 

user photo 

Step 4: Select a user Role 

Step 5: Select 

hospitals you want 

the user to access 

Step 1: Enter User 

Personal Information 
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Note:  

• Picture upload - allows admins to add a user photo 

• Password textbox - allows admins to add a temporally password for users (8 

characters minimum) 

• Employment status – allows admins to indicate whether a technician is pin 

coded or a volunteer 

• Allowed health facilities – Users can be given access to more than one 

facility. 

• Default Hospital – The actual health facility assigned to users. 

• Role – Is the permission given to a user. This allows/restrict a user from 

accessing a particular module.  

When the Technician Role is selected from the dropdown, additional fields 

will be displayed, allowing the CMMS Administrator to capture a complete 

profile of the technicians. 

 

In the Add User form, when a technician role is selected in the dropdown, the 

following fields will display as shown below. 

 

 

Note: For the Qualification and Trainings, users should press the ENTER KEY 

after each entry. 

 

3.1.5 Exporting users’ information 

To export technicians’ detail to MS Excel 

Step 1: On the Users form, Click the Download button near Users.  

The downloaded Excel sheet will display on the taskbar 

Step 7: Select 

a Technician 

Speciality from 

the dropdown 

Step 8: Enter a user 

Qualification 

Step 9: Add Trainings 

completed by user 

Step 10: Click Submit 

to save user profile 
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Step 2: Click on the options dropdown and select Open  

 

 

 

 

 

 

 

 

 

The open Excel file with users’ details will display as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step1: Click Download 

Step 2: Select dropdown on the 

downloaded excel file and select 

Open Speciality from the dropdown
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4.0 CMMS Maintenance Overview 

 

The maintenance module allows users to: 

• Configure CMMS dropdown fields (Equipment Name, Donors, Equipment 

Category, Current Location, Used in Location etc). CMMS Administrators 

Only. 

• Record/update Asset Register at facility level 

• Log maintenance request 

• Complete the Job order for equipment maintenance and track progress 

• Record spare parts supplies and consumption  

• Generate monthly/quarterly reports as requested by Management. 

When you Sign-In as Technician, you have access to the:  

• Maintenance Module – Use for Inventory management, Maintenance 

Request, Scheduling and Reporting.  

• Spare Parts Module – Use for recording supplies and consumption of 

equipment’s parts. 

• Based on the permissions and role, other users are restricted from using 

the Settings Module and the Configuration module.  

 

To update hospital daily maintenance management activities, select the 

Maintenance module from the home page as shown below. 

 

The screen below (Dashboard) will display after selecting maintenance. 
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Equipment 

registered by 

facility in 

the country 

Summary of 

Spare Parts 

Registered 

Summary of 

Equipment’s 

Received from 

Donor/Govt 

Total 

equipment 

registered 

and status 

Summary of 

Maintenance 

Request 

Received 

Equipment 

registered by 

Location in 

the hospital 

4.1 Dashboard 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The dashboard displays information about tasks for internal and external maintenance, 

Referral Maintenance Unit as well as sub-contractors for medical devices and 

infrastructure. Maintenance teams will populate the dashboard by creating both 

corrective and preventive maintenance scheduling.  

The instance requests will be listed under the maintenance teams. These requests are 

categorised as TO DO items scheduled and Unscheduled. If you click on any of 

the Teams, you'll be taken to the requests listed. 

By default, the dashboard shows a summary of all CMMS activities country wide. The 

dashboard also has a drop-down option to select a facility and the summary of 

activities of the selected facility will display on the dashboard.   

 

 

Select 

Dashboard 

TO DO list items 

for Schedule & 

Unscheduled 

 

 

 Select FACILITY to display summary by Health Facility on the Dashboard  
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The information displayed on the dashboard includes:  

• Equipment Registered by hospital 

• Spare Parts registered 

• Equipment Registered by Location in the hospital  

• Equipment received from donor/partners/government,  

• Total equipment Registered and their status  

• Number of requests received  

4.2 Configurations Module (CMMS Administrators Only) 

Managing configurations is done by the CMMS Administrator. This involves creating 

Equipment master list, Maintenance Teams, Equipment Categories, Current 

Location, Used in Location, Donor/Partner/Govt etc. 

4.2.1 Maintenance Teams 

This involves segmenting the maintenance staff into teams so that job order can be 

assigned to staff based on speciality. 

The maintenance teams for CMMS are: 

• Internal maintenance – Medical devices: Technician within the facility 

specialized in repairing medical devices. 

• External maintenance – Medical devices: Technician outside the facility 

(from another health facility) specialized in repairing medical devices. 

• Internal maintenance – Infrastructure: Technician within the facility 

specialized in repairing hospital infrastructure. 

• External maintenance – Infrastructures: Technician outside the facility (from 

another health facility) specialized in repairing facility infrastructure. 

• Referral Maintenance Unit (RMU) – Zonal maintenance units setup to 

support the DHMT technicians and other health facilities that does not have 

highly skilled technicians.  

• Sub-contractor – Someone contacted to provide service for the hospital.  
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To create a Maintenance Team, 

Step 1: From the Configuration Tab, Select Maintenance Teams.  

Step 2: Click the Create button on the Teams form on the right 

 

 

 

 

 

 

 

In the add team dialog box, 

Step 3: Enter Team name.  

Step 4: Select health facility for the team from the dropdown and Click Save 

 

 

 

 

 

 

 

4.2.2 Equipment Category 

Creating and maintaining Equipment categories can help in the efficient management 

of various types of equipment. 

To create and manage equipment categories,  

Step 1: Go to the Configuration tab on the maintenance module's dashboard and 

select Equipment Categories from the drop-down menu.  

 

Step 3: Enter a Team name  

Step 4: Select facility for Team 

name and click Save 

 

Step 1: Select Maintenance 

Teams from the Configuration tab 

Step 2: Click Create  
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As illustrated below, a new page will appear. 

 

In the add Category dialog box, 

Step 3: Enter Category Name, Responsible Technician, and Description  

Step 4: Click Save.  

.  

 

 

 

 

4.2.3 Equipment Master 

Creating and maintaining Equipment Master list can help in the standardization of 

medical equipment names for easy analysis. All equipment added will display on the 

dropdown for Equipment Name on the Inventory Module. 

 

To create and manage equipment master list,  

Step 1: Go to the Configuration tab on the maintenance module's and select 

Equipment Master from the drop-down menu.  

 

Step 3: Enter an Equipment 

Category name, select a 

Responsible technician 

from the dropdown, provide 

a brief description of 

category 

Step 4: 

Click Save 

Step 1: Select Equipment Categories 

from the Configuration tab 

Step 2: Click Create  
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As illustrated below, a new page will appear. 

 

In the add/Edit Equipment dialog box, 

Step 3: Enter Equipment Name 

Step 4: Click Save.  

 

 

 

4.2.4 Equipment Location 

Creating and maintaining Equipment Locations list can help in the determining the 

current location of equipment’s and the department/section in the hospital they are 

used. This makes it easy tracking the movement of equipment’s.  

 

To create and manage equipment location,  

Step 1: Go to the Configuration tab on the maintenance module's dashboard and 

select Location from the drop-down menu.  

In the new window, select Create on the top right. A new dialog box will appear as 

illustrated below. 

 

 

Step 1: Enter Equipment Name 

Step 2: Click Save 

 

Step 1: Select Equipment Master 

from the Configuration tab 

Step 2: Click Create  

 

Step 3: Enter an 

Equipment Name 

Step 4: 

Click Save 

 Step 1: Enter an 

Equipment Name 

Step 2: 

Click Save 
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NOTE:  

Use the similar steps as above to populate dropdown list for:  

 Donor/Partners/Govt – The displays the institutions supplying/donating 

equipment’s to the facilities. 

 Unit of Measure (Spare Parts)  

 Spare Part Location – Locations where spare parts are from 

 Item master - Spare part Name 

 Primary Facility – PHUs name at the DHMTs  

 Setting – To upload an updated flyer and manual for CMMS 

4.3 Equipment Inventory 

This is considered the first activity in Maintenance management. All equipment’s 

MUST be registered in the CMMS Equipment Inventory module before a 

maintenance request can be submitted.  

On the Equipment Inventory tab, Technicians can 

• Search for an equipment 

• Register/update an equipment 

• Schedule Preventive Maintenance 

• Download to MS Excel list of registered equipment. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Search for an Equipment 

based on search criteria e.g., Status 

 

Step 1: Click Equipment 

Inventory Tab  

Step 4: Click 

Create to register 

an equipment  

List of Equipment registered on CMMS 

Step 5: Download list 

of registered equipment 

to MS Excel 

Step 3: Click Bulk Upload 

to register equipment’s 

from an Excel file 
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To register a new equipment 

• Click the Create button in Step 4 above under the Equipment Inventory tab 

• In the add Equipment form, complete the fields as shown below. 

 

 

 

 

 

 

 

 

 

Key Fields 

Equipment Name – Select from the dropdown. If not on the list, contact the CMMS 

Administrator to add equipment in the master list. 

Current Location – If users select CHC, PHU, MCHP, BEMONC, then the new field 

“Primary Care Facility” will display allowing users to write the name of the PHU 

facility. Note: This field is used to track equipment’s from the PHU’s. 

• Click the Product Information tab in the add Equipment form, complete 

the fields as shown below. 

 

• Click the Maintenance tab in the add Equipment form, complete the fields 

to schedule Preventive maintenance as shown below. 

 

Click tab to complete the Product Information fields 
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 Enter a Preventive Maintenance Frequency and maintenance 

Duration. 

 CMMS will automatically calculate the Next Preventive Maintenance 

date as shown on the right 

 

 

 

 

 

 

 

• Click the Save button to save an equipment.  
 

4.3.1. Editing / Deleting an equipment 

To Edit/delete and equipment, 

 Click the ellipses (…) on the equipment name and select 

 

 

 

• Edit – Make changes to the fields you desire and click save 

• Delete – Permanently remove the equipment from the inventory list  

 

4.3.2 Using the Bulk Upload 

To upload a list of equipment’s entered in an excel sheet offline,  

Step 1: Click the Bulk Upload button above as shown below. 

Step 2: Click Choose file to upload the excel sheet 

Step 3: Click Save to update your equipment register 

 

Click Save to complete equipment registration 

 

Click ellipses (…) on the equipment name 

 

CMMS automatically calculate and set 

Next Preventive Maintenance date 
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NOTE: 

 Click on the Sample Excel file to download it 

 Make sure the Excel file to be uploaded is in e same format as the sample 

 Save the Excel file as a comma delimited file before uploading. 

 

4.3.3 Scheduling an Activity for an equipment 

To schedule and activity, 

Step 1: Click on the Clock icon close to the equipment, select Schedule Activity 

 

 

 

 

 

 

 

In the new window, complete the activity fields as shown below 

 

 

 

 

 

Step 2: Click on the Schedule button to update the Schedule Activity 

 

 

 

Click Clock icon on the equipment 

name and select Schedule Activity  

 

Step 1: Click Bulk Upload 

Step 2: Click Choose File 

Step 3: Click Save 
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4.3.4 Export/Download Equipment Inventory list to MS Excel 

To export Equipment Inventory list to MS Excel 

Step 1: On the Equipment Inventory form, specify from the search options which data you 

want to view/export into MS Excel and click search e.g., Equipment Name, 

Donor/Partner/Govt, Location, Status etc. 

Step 2: Click the Download button  

The downloaded Excel sheet will display on the taskbar 

Step 3: Click on the options dropdown and select Open  

 

 

 

 

 

 

 

 

The open Excel file with Equipment’s list will display as shown below. 

 

 

 

 

Step 2: Click Download 

 

Step 3: Select dropdown on the 

downloaded excel file and select Open  

 

Step 1: specify data to 

export and click search  
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4.4 Maintenance Request 

 

The Maintenance module allow the users to carry out maintenance in two different 

ways: 

• Preventive – Is carried out to prevent machine dysfunction by offering routine 

maintenance support. Technicians can schedule maintenance in advance and carry 

out all activities on time. This prevents the equipment from suffering from 

unexpected damages and ensures maximum utilization of the machines.  

• Corrective – Though the maintenance team carry out regular maintenance work, 

some equipment may go defunct at times. This issue must be addressed quickly, 

and corrective maintenance comes to the rescue in such situations. A user can 

register a maintenance request and alert the maintenance team about the issue. 

This helps the team to immediately address the issue. 

Even though there are two types of maintenance, the process for creating 

maintenance requests is almost the same.  

4.4.1 Creating a Maintenance Request 

To create a Maintenance request  

• Step 1: Click the Maintenance tab and select Maintenance Request 

 

 

 

 

 

 

• Step 2: Click the Create button on the top right. The maintenance requests 

form will appear, as shown below. 

In the Maintenance Request form, the user can add the details of the request (problem 

reported), equipment name with serial number, request date, request submitted by, 

maintenance team, schedule date, duration, priority, and email addresses to copy 

request. Users can also add Internal Notes, giving a more detailed description of 

the how the problem will be solved, what spares may be required, and what was done 

to resolve the problem. 

 

Step 1: Select maintenance request 

from the Maintenance dropdown 

Step 2: Click 

Create button 
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The user can generate corrective maintenance requests and preventing 

maintenance requests.  

 

 

 

 

 

 

 

 

• Step 3: Click Save button to update a request 
 

4.4.2 Export/Download Maintenance requests to MS Excel 

To view/export Maintenance requests to MS Excel 

Step 1: On the Maintenance Request form, specify from the search options which data you 

want to view/export into MS Excel and click search e.g., Equipment Name, Maintenance Type 

(Preventive or Corrective), Date range request capture, Status etc. 

Click the Download button  

The downloaded Excel sheet will display on the taskbar 

Step 2: Click on the options dropdown and select Open  

 

 

 

 

 

 

 

 

Stage of the 

request  

Step 1: Click Download  

Step 2: Select dropdown on the 

downloaded excel file and select Open  

Enter details of staff 

making the request 

Enter additional 

notes on the 

Maintenance  

 

 

 

 

 

Step 3: Click Save button 

Send a copy of the 

request to specific 

recipients. Separate 

the emails address 

by a comma, to send 

to multiple emails  

 

An outcome date is 

required when stage of 

maintenance change to 

Repaired or Scrap 

Assign request 

to a team and a 

technician 

Indicate stage of 

the request  

Select the equipment from 

the search textbox by 

typing equipment name 

Describe the request 

Select the 

Maintenance type 
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The open Excel file with Equipment’s list will display as shown below 
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5.0 Spare Parts Overview 

 

The spare parts module allows users to: 

• Record/update information about the type and quantity of spares received from 

MOHS/Donors/Partners 

• record information on the quantity of spares parts use at facility level and for 

which equipment’s they are used for. 

When you Sign-In as Technician, you have access to the:  

• Spare Part supplies – Use to update supplies received for spare parts from 

MOHS/Donors.  

• Spare Parts Consumption – Use for recording consumption of equipment’s 

parts. 

5.1 Spare Parts Supplies 

 

On the Spare Parts Supplies form, Technicians can 

• Search for spares  

• Register/update spare parts 

To create/add a new spare part supplied into the CMMS 

• Step 1: Click the Spare Parts tab and select Spare Parts Supplies 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 1: Select Spare 

Parts Supplies  

 

 

Step 2: Select Create  

 

 

List of 

Spare 

Parts 

Supplies 

registered 

Click to Edit Spare 

Parts Supplies  

Click download button 

to export Spare Parts 

Supplies to MS Excel 

Click to Delete Spare 

Parts Supplies  
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• Step 2: Click the Create button on the top right. The Add Spare Parts form 

will appear, as shown below. 

 

Complete the form by enter data in the field shown in the form 

NOTE: 

Fields highlighted in RED are REQUIRED fields and must be completed before the 

form will be saved. 

 

 

 

 

 

 

 

 

 

 

• Step 3: Click the Submit button to save and Cancel to discard the changes. 
 

 

5.2 Spare Parts Consumption 

 

On the Spare Parts Consumption form, Technicians can 

• Search for used spares parts 

• Record spare parts used for maintenance  

 

 

 

 

Step 3: Select Submit to save 
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To create/add a used spare part supplied into the CMMS 

• Step 1: Click the Spare Parts tab and select Spare Parts Consumption 

 

 

 

 

• Step 2: Click the Create button on the top right. The Add Spare Parts 

Consumption form will appear, as shown below. 

 

 Complete the following fields 

 Enter Consumption Date – Date Spare part was used for equipment repairs 

 Select Part Name from dropdown – Part Name & number is queried from 

Spare parts supplies i.e. Part name should have been added in the Spare 

parts supplies 

 Select Equipment Name – Equipment name & Serial No is queried from 

Equipment Inventory list i.e. Equipment should exist in the inventory 

 Enter Quantity – Number of spares used to do the maintenance 

 

 

 

 

 

 

 

 

Step 3: Click the Submit button to Save and Cancel to discard the changes. 

Step 1: Select Spare 

Parts Consumption  

 

 

Step 2: Select Create  

 

 

List of Spare 

Parts 

Consumption 

registered 

Click download button to 

export Spare Parts 

Consumption to MS Excel 

Click to Delete Spare 

Parts Consumption 

Click to Edit Spare 

Parts Consumption  

Step 3: Select 

Submit to save 
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6.0 ACTIVITY LOG 

 

The CMMS Activity Logs provide immediate, basic information about what is 

happening in the CMMS, and how users are interacting with the system modules.  

Auditing is a review and analysis of management, operational, and technical controls. 

The Activity Logs shows a sequential record of all the activity on the CMMS.  

By reviewing Activity logs, systems administrators can track user activity, and 

security teams can investigate breaches and ensure compliance with regulatory 

requirements. 

To view CMMS Activity Logs: 

• Step 1: Click the Activity logs tab from the main menu 

 

 

 

 

 

 

 

 

• Step 2: To see activity that took place during a specific period, enter a start 

and end date next to From and To Date, and click Submit 

The activity list report for the period will be displayed as shown above 

 

 

 

 

 

Step 1: Select Activity Logs  

 

Step 2: Specify a date 

range and click Submit  

 

CMMS 

Activity 

Log report 

 

Use the Search box to extract information on activity based on user or action  
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7.0 REPORTING 

 

CMMS reporting module gives every user, irrespective of technological expertise, the 

ability to analyse data in real time via intuitive charts. Viewing any form of information 

using graphics makes data easier to understand, analyse, and process into actionable 

insights. 

Three types of reports can be viewed/generated in CMMS 

 Maintenance request 

 Equipment Inventory 

 Spare Parts 

7.1 Maintenance request Reports 

The Maintenance request report displays activities and performance of technicians 

on their routine maintenance activities using the work order system. The report 

displays a summary on the number of requests submitted by each technician and 

the stage of each request (New request, In progress, Repaired and Scrap). 

By default, the form is display using a bar chart. Users can switch the view to a Pie 

chart and as well download the report to MS Excel. 
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To view Maintenance requests reports: 

• Step 1: Click the Reporting tab from the main menu and select 

Maintenance request 

 

 

 

 

 

 

 

 

• Step 2: Click the Switch chart button to see the technician’s performance in 

a Pie Chart 

 

 

 

 

 

Step 1: Select 

Maintenance Request  

 

Switch Chart view  

Export to MS Excel  

Chart Legend showing 

stage of Maintenance  

 

Names of technicians in CMMS  

Bars showing the 

summary of each 

technician in CMMS 

assigned to a request  

 

 
 

Switch Chart view  
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7.2 Equipment Inventory Report 

The Equipment Inventory report displays the total number of equipment’s 

registered at each facility using the CMMS Inventory Module. 

By default, the form is display using a bar chart. Users can switch the view to a Pie 

chart and as well download the report to MS Excel. 

To view Equipment Inventory reports: 

• Step 1: Click the Reporting tab from the main menu and select Equipment 

Inventory. 

 

 

 

 

 

 

 

 

 
 
 
 
 

Step 2: Click Switch chart button to see Equipment Inventory by Facility in a Pie Chart 

 

 

 

 

 

 

 

 

 

Switch Chart view  

 

Names of 

facilities in CMMS 

 

Step 1: Select Equipment 

Inventory  

Export to MS Excel  

Switch Chart view  

Bars showing the summary 

of Equipment Inventory in 

CMMS for each facility 
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7.3 Spare Parts Report 

The Spare Parts report displays the total number of used and unused spares for all 

facilities in the CMMS. 

By default, the form is display using a component bar chart. Users can switch the 

view to a Pie chart and as well download the report to MS Excel. 

To view Spare Parts reports: 

• Step 1: Click the Reporting tab from the main menu and select Spare Parts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Click Switch chart button to see Spare Parts by Facility in a Pie Chart  

 

 

 

 

 

 

 

 

 

 

Step 1: Select 

Spare Parts  

 

Export to MS Excel  

Switch Chart view  

 

 

Chart Legend showing 

Unused and used Spare parts  

Bars showing 

the summary 

of Spare Parts 

Supplies and 

Consumption 

in CMMS for 

all facility 

Switch Chart view  
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To view Spare Parts supplies and Consumption by Facility,  

Step 3: Click the dropdown button and select the name of the facility you want to view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1: Select Facility 

from the dropdown   
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8.0 GENERATING CUSTOM REPORTS (DATA ANALYSIS) 

 

Data analysis involves a process of cleaning, studying, and displaying data to discover 

useful information for decision-making. The goal is to find meaning in data so that the 

derived knowledge can be used to make informed decisions.  

The Data Analysis Process involves: 

• Data Collection:  Data collection has been defined in the CMMS application 

already. Users only need to know what data they are planning to analyse and how 

to get the data exported from CMMS to an Excel spreadsheet for analysis. 

• Data Cleaning: Not all the data exported from CMMS will be useful for a specific 

report, so it’s necessary to clean it. This process of data cleaning is where you 

remove white spaces, duplicate records, and basic errors. Data cleaning is 

mandatory before data analysis. 

• Data Analysis: Here you use data analysis software and other tools to help you 

interpret and understand the data and arrive at conclusions. Basic data analysis 

tool is Excel, other tools exist like SPSS, Microsoft Power BI etc. 

• Data Interpretation and Visualisation: To deduce the result and determine 

the best courses of action, based on the findings. Visualisation helps to derive 

valuable insights by helping you compare datasets and observe relationships 

graphically.  

8.1 Preparing the spreadsheet for analysis 

8.1.1 Clean the Data  

We are taking the Maintenance request report as our example. Export/Download 

Maintenance requests to MS Excel and Delete unwanted data (unnecessary rows and 

columns) 
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Step 1: Highlight the rows/columns you want to delete. 

 

Step 2: Right click and select Delete 

 

8.1.2  Wrap text 

Select the cells that you wish to wrap text in  

 

 

 

 

 

 

8.1.3 Freezing the top row 

You may want to see certain rows or columns all the time in your worksheet, 

especially header cells. Freezing rows or columns allows you to scroll through your 

content while continuing to view the frozen cells.  

Step 1: Highlight unwanted 

rows/columns to Delete 

Step 2: Right Click 

and select Delete  

 

Step 1: Click 

and drag across 

the Header row 

to Select it  

Step 2: Click Wrap Text 

from the Home Tab 
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Freezing the top row of titles makes it easier to identify what column you're looking 

at as you scroll through the data set. 

Step 1: Select row 1 by clicking on the number 1 on the far left of the page. This will 

highlight all cells in this row 

Step 2: Select the "View" tab at the top of the page  

Step 3: click on the "Freeze Top Row" option 

 

 

 

 

 

 

This will now mean when you scroll down the page, the titles of each row will remain 

visible 

• To unfreeze rows or columns, click the Freeze Panes command, then 

select Unfreeze Panes from the drop-down menu. 

8.1.4 Enable filters 

Filters allow you to quickly organise and separate out information that you need from 

the dataset. They are essential to extract data needed based on the criteria.  

If your worksheet contains a lot of content, it can be difficult to find information 

quickly. Filters can be used to narrow down the data in your worksheet, allowing you 

to view only the information you need. By default, all data exported to MS Excel from 

CMMS has filters enabled. However, if filters are not enabled,  

Step 1: Click 

number 1 to 

highlight Row1 

Step 3. Select 

Freeze Top Row  

Step 2: Select View tab, from the 

main menu and Click Freeze Panes 
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• To enable filters, click on the Home tab and select Sort & Filter command 

and select Filter 

When filters are activated, a drop-down arrow will appear in the header cell for 

each column. 

• Filtering options can also be accessed from the Filter command on 

the Data tab 

 

 

8.1.5 Using filters 

To filter a data column e.g., Column L (Stage) 

Step 1: Click the drop-down arrow for the column you want to filter. In our 

example, we will filter column L to view equipment based on stage of maintenance. 

Step 2: Uncheck the box next to Select All to quickly deselect all data. 

 

 

 

 

 
 

 

Step 1. Click Dropdown 

arrow for the Stage Column 

Step 2: Uncheck the 

boxes to deselect 

the data you don’t 

want to display 

Step 3. Click Ok 
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Step 3: Check the boxes next to the data you want to filter, then click OK.  

In this example, we will check NewRequest to view only new maintenance request. 

The data will be filtered, temporarily hiding any content that doesn't match the 

criteria. In our example, only NewRequest maintenance stages are visible as shown 

below. 

 

8.1.6 Applying multiple filters 

Filters are cumulative, which means you can apply multiple filters to help narrow 

down your results. In this example, we've already filtered our worksheet to show New 

Request stage of maintenance, we'd like to narrow it down further to only show New 

Request for Preventive maintenance. 

• Step 1: Click the drop-down arrow for the column you want to filter. In this 

example, we will add a filter to column G to view information by Maintenance 

Type. 

The Filter menu will appear. 

• Step 2: Check or uncheck the boxes depending on the data you want to filter, 

then click OK. In the example below, we'll uncheck everything except 

for Preventive. 
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The new filter will be applied. In our example, the worksheet is now filtered to show 

only New Request for Preventive Maintenance. 

  

8.1.7 Clear a filter 

After applying a filter, you may want to remove—or clear—it from your worksheet so 

you'll be able to filter content in different ways. 

• Step 1: Click the drop-down arrow for the filter you want to clear. In our 

example, we'll clear the filter in column G. The Filter menu will appear as 

shown below. 

  

Step 1. Click Dropdown 

arrow for the Maintenance 

Type Column 
Step 2. Check the boxes for 

Preventive and Uncheck the 

boxes to deselect the data you 

don’t want to display 

Step 1. Click 

Dropdown arrow 

for Maintenance 

Type Column 

 

Step 2. Click Clear Filter 

From “Maintenance Type”  
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• Step 2: Choose Clear Filter From [COLUMN NAME] from the Filter menu. 

In our example, we'll select Clear Filter From "Maintenance Type". 

The filter will be cleared from the column. The previously hidden data will be displayed. 

To remove all filters from your worksheet, click the Filter command on the Data tab. 

 

 

 

 

8.1.8 Copying and Moving Filtered data to a new Sheet 

We are moving/copying our filtered data to a new worksheet for analysis. 

• Step 1: Select/Highlight the data you want to move to a new sheet 

• Step 2: Select the Copy 

 

 

 

 

 

 

 

 

 

8.1.9 Creating a new worksheet 

A workbook is an Excel file, while a worksheet is one of the spreadsheets in 

that file. A workbook can contain multiple worksheets. 

Step 1: Click the add worksheet button near the worksheet tabs: 

Step 2: On the new sheet, Click on the first Cell “A1” 

 

 

Step 2. Click Copy  

Preview of 

Copied 

Cells/data  

 

Step 1. Click 

small triangle to 

highlight all data  
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Step 3: Click Paste 

Step 4: To rename the new sheet, Right click on the new sheet and select Rename. 

E.g., Preventive Maintenance Schedule   

 

 

 

 

 

 

 

It will always be the right-most sheet in your workbook.  

Below is the data we have moved to a new sheet.  

 

 

 

 

Step 1: Click + to add 

a new worksheet 

Step 2: Click on 

the first Cell “A1” 

Step 3: Click Paste  

Step 4: Right click on the new sheet 

and select Rename. E.g., 

Preventive Maintenance Schedule  
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8.2 PivotTables 

For data analysis and reporting, different datasets will be exported to Microsoft Excel, 

these includes Users profile, Equipment Inventory, Maintenance request and Spare 

parts consumption. 

 

8.2.1 Using Pivot Tables to generate reports 

When you have a lot of data, it can sometimes be difficult to analyse all the information 

in your worksheet. PivotTables can help make your worksheets more manageable 

by summarising data and allowing you to manipulate it in different ways. 

To create a PivotTable: 

Step 1: Select the table or cells (including column headers) containing the data  

Step 2: From the Insert tab, click the PivotTable command.  

 

 

 

 

 

 

The Create PivotTable dialog box will appear as shown below. Choose your settings, 

then click OK. In our example, we'll use Maintenance Request as our source data 

and place the PivotTable on a new worksheet. 

Step 1. Click 

small triangle to 

highlight all data  

Step 2. Select 

Pivot Table 
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A blank PivotTable and Field List will appear on a new worksheet. 

Once you create a PivotTable, you'll need to decide which fields to add. Each field is 

simply a column header from the source data.  

In the PivotTable Field List, check the box for each field you want to add. In our 

example, we want to know for different Maintenance Type by Stage, so we'll  

• Step 1: check the Maintenance Type and Stage fields  

 

 

 

 

 

 

 

 

The selected fields will be added to one of the four areas below the Field List. In our 

example, the Stage field has been added to the Column area and Maintenance 

Type to Rows.  

Adding the Maintenance Type to the Values area.  

  

 

Step 1: Check Maintenance 

Type and Stage 

Add Maintenance 

Type field to the Rows 

Add Stage field 

to the Columns 

Add Maintenance 

Type field to 

the Values 

A blank 

Pivot table 

Field list 

Place pivot 

table in a 

new 

worksheet 

Specify 

Source data 

i.e., based on 

selection 
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Alternatively, you can click, hold, and drag a field to the desired area.  

 

The PivotTable will calculate and summarize the selected fields. In our example, the 

PivotTable shows the total number of requests submitted for different 

maintenance type by stage. 

If you change any of the data in your source worksheet, the PivotTable will not 

update automatically. To manually update it, select the PivotTable and then go 

to Analyse > Refresh. 

 

 

 

 

8.3 Pivoting data 

One of the best things about PivotTables is that they can quickly pivot - or reorganise 

- data, allowing you to look at your worksheet data in different ways. Pivoting data 

can help you answer different questions and even experiment with the data to 

discover new trends and patterns. 
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In our example, we used the PivotTable to answer the question: How many 

maintenance requests were submitted at the facility for the different 

Maintenance types by Stage? But now we'd like to answer a new question:  

What Priority was used for each Maintenance type based on Stage?  

We can do this by simply changing/adding a field in the Rows or Values area. 

To change the row: 

• Click, hold, and drag any existing fields out of the Rows area. The field will 

disappear. 

To add a new row: 

Step 1: Drag a new field from the Field List into the Values area. In our example, 

we'll use the Type field.  

Step 2: Use the Filter options to remove blank cells 

Step 3: Deselect/Unchecked Blank 

Step 4: Click Ok to apply filters and preview data 

 

Converting Values to Percentages and displaying the result on a Chart 

Step 1: Click on the field in the value box e.g., Count of Gender and select Value 

Field Setting……. 

 

 

 

 

 

 

 

Step 2: From the Value Settings Dialog box, Select Show Values As >> % of 

Grand Total from the dropdown and Click Ok when finish. 

Step 1. Click dropdown 

on the field in the values 

area. Select “Value 

Field Settings….” 

Step 2: Click 

dropdown 

Select “% of 

Grand Total” 

Click “Ok” 

when done 
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To Decrease the Decimal places,  

Step 1: Highlight the cells in % 

Step 2: From the Home Tab, Click the Decrease Decimal icon.  

 

8.4 Pivot Charts 

Pivot Charts are like regular charts, except they display data from a PivotTable. 

Just like regular charts, you'll be able to select a chart type, layout, and style that 

will best represent the data. 

 

To create a PivotChart: 

In this example, our PivotTable is showing the percentage Maintenance type. We'll 

use a PivotChart so we can see the information more clearly. 

Step 1: Select/Click any cell in your PivotTable.  

Step 2: From the Insert tab, click the PivotChart command. 

 

 

 

 

Step 2: Click to decrease 

“Decimal places” 

Step 1. Highlight 

the Cells in % 
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The Insert Chart dialog box will appear. Select the desired chart type and layout, 

then click OK. 

 

 

 

 

 

 

 

 

 

The PivotChart will appear as shown below. 

Step 1: Click on any 

cell in the table 

Step 2: Click 

“PivotChart” 

 

 

 

Step 1: Select a 

“Chart type” e.g. 

Column or Bar chart 

Step 2: Select a 

“Chart Layout 
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To copy a chart/table to a word document 

• Select the chart/table 

• Click Copy 

Switch to the document window you want to move your chart/table.  

Move the cursor where you want to paste. 

From the HOME tab, Click Paste 
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9.0 POLICIES FOR CMMS USERS 

1. ASSET MANAGEMENT 

2. USER MANAGEMENT POLICY – CMMS 

3. Data Protection Policy 

 

 

 

9.1 ASSET MANAGEMENT 

9.1.1 Introduction  

This asset management policy provides a framework for the appropriate and effective 

management of IT equipment (hardware and software) as well as other workshop 

tools from procurement to disposal for Maintenance Units.  

It defines responsibilities that relate to the implementation of this policy and is 

designed to ensure that assets are:  

• Managed appropriately from the point of acquisition to the time of disposal in 

a way that is compliant with health facility policies and regulatory obligations.  

• Registered within the hospital asset management system for tracking and 

auditing purposes.  

• Supported and maintained throughout their lifecycle so that they deliver best 

value for the investment.  

• For IT asset, ensured they are controlled effectively to protect the data and 

information that are stored or transmitted.  

• Managed for the identification of risk and business continuity planning.  

This policy does not stand in isolation and shall be implemented in conjunction with 

the wider range of assets, information security, procurement and financial related 

policies of MOHS.  
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9.1.2 Policy Scope  

This policy applies to all physical assets purchased by the government or procured by 

partners for the health facility specifically the Maintenance Units that form part of the 

maintenance unit asset and infrastructure.  

A physical asset is defined as:  

• All IT assets,  

o desktop and laptop computers and related cables.  

o Dongles/modems, portable storage devices, other network 

infrastructure etc; System software, client applications and associated 

licences.  

o Any other IT peripheral devices (such as mouse, keyboard etc).  

• Workshop tools and equipment’s for maintenance activities 

This policy applies to all hospital staff and other associates of maintenance unit, 

including partner organisations, and suppliers, who request or hold assets purchased 

on behalf of maintenance units.  

9.1.3 Policy Intent  

This policy is produced to provide a clear instruction on the appropriate management 

of assets to help ensure that the maintenance unit is meeting its legal, regulatory, 

contractual obligations. This policy has also been developed to help the maintenance 

units to maximise the investment in resources and technology and secure the best 

value for money from its assets.  

9.1.4 Policy Provisions and Principles  

a. Management of Assets  

• All assets purchased for use by the maintenance unit are the property of the 

facility and will be utilised in a way that is deemed most effective for addressing 

the units needs and objectively demonstrates value for money.  
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• For compatibility and efficiency reasons, assets will be issued on a ‘fit for 

purpose’ basis based on predefined roles.  

• Enquiries about and requests for individual assets must be submitted to the 

head of maintenance via the Hospital Secretary in accordance with current 

ordering processes and procedures.  

• For IT asset replacement, DPPI will assess requests for new equipment’s fulfil 

them with standard IT equipment that best fit the requirement by aiming to 

reissue assets held in the centralised store in the first instance. Requests for 

non-standard IT equipment or specialist IT equipment will be assessed by the 

hospital management and approved via a business case through the 

appropriate channels. The total cost of the assets will be added to the 

maintenance unit budget in the AWP if the purchase is authorised by the 

Hospital Management.  

The procurement of IT assets must be undertaken in consultation with DPPI 

from inception. DPPI is responsible for engaging with the Procurement Team 

and ensuring that the best procurement practice is followed as per the MOHS 

policies and applicable legislation.  

The hospital management will not, without adequate and suitable further 

justification, approve or proceed with the procurement of IT assets that do not 

comply with the requirements of the maintenance unit Strategic Plan. 

End users are not allowed to install unapproved software on devices. Requests 

should be made to DPPI-MOHS IT Service Desk to have additional software that 

is not on the approved hardware and software list installed on to a device.  

• End users must always contact HS & DPPI-MOHS IT Service Desk if they need 

to move, reassign, or return IT equipment.  

• In order to ensure the confidentiality of information, any IT asset that has been 

used to process or store personal or sensitive information will be wiped before 

being reissued.  
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• All assets purchased (excluding consumable items, e.g., printing paper, printer 

cartridge) will be registered in the asset register and be asset tagged before 

being issued or put into use.  

• Information about all assets will be held in the asset register, which will be 

maintained by the HS, to enable them to be tracked, managed, and audited 

throughout their entire lifecycle.  

The maintenance unit must comply with this policy. A breach of this policy may result 

in being prevented from using maintenance unit provided equipment’s/tools. A breach 

may also need to be dealt with in accordance with relevant policies  

Individual users or the unit will be held responsible for protecting ALL assets that have 

been assigned to them against physical or financial loss whether by theft, mishandling 

or accidental damage by using appropriate physical security measures.  

 

b. Responsibilities  

Head of Maintenance 

The head of maintenance is accountable for the implementation of this policy in the 

unit. The Maintenance head will be responsible for:  

• Coordinating asset audit activity such as annual inventory checks for 

management reporting including the annual audit report for the hospital 

management 

• Updating and maintaining the accuracy of the asset register as soon as a 

change is made (including office moves, reports of lost or stolen equipment 

and disposals) 

• Ensuring that asset/tools signed for by end users when they are assigned and 

is recorded in a register 

• Ensuring that all assets are processed, and asset tagged before they are issued 

to end users 

• Ensuring that any asset that is retired is disposed of in accordance with relevant 

policies 
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• Giving correct and appropriate advice to users on the correct handling of 

asset/tools 

• Reporting any incorrect disposal or misuse of an asset to an appropriate 

manager within the hospital as soon as possible.  

End users 

End users assigned with assets/other workshop tools will be responsible for:  

• Retaining responsibility for an asset/tool assigned to them  

• Ensuring that asset/tools are not moved to another location (if fixed) or 

transferred to another person or department without the consent of the unit 

head;  

• Reporting the loss or theft of IT assets/tools immediately to the unit head 

• Reporting immediately any defects to IT assets/tools that are not operating 

normally to the relevant authority via the unit head.  

9.1.5 Compliance  

Any actual or suspected breach of this policy, the maintenance head will take 

appropriate action and inform the relevant internal and external authorities.  
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9.2.0 USER MANAGEMENT POLICY – CMMS 

 

9.2.1 Introduction  

This document defines the user access management policy for the Computerised 

Maintenance Management System ensuring account access is authorised and 

underpins the requirements of relevant policies 

9.2.2 Policy Statement and scope 

• This document defines the user access management policy for all users and 

this policy applies to CMMS and services hosted both internally and externally, 

included nationally hosted systems.  

• The policy describes the registration and de-registration process of user 

accounts and applies to staff (including new starter and leavers) and those 

moving roles as well as temporary staff (including students, volunteers, third 

party and contract staff) 

• Access to the CMMS will be subject to approval by the DPPI-MOHS relevant 

system administrators through a request to HSS from the head of maintenance 

or HS.  

9.2.3 Objectives  

This policy will ensure that appropriate procedures are in place to manage the process 

for new user accounts, amendments to user privileges for staff that have left the 

institution to ensure the confidentiality of hospital inventory and maintenance data. 

9.2.4 Procedures  

The unit head with IT support will follow the relevant procedure to grant access to 

new users, deactivation of staff leaving their unit/facility and role changes are 

undertaken in line with requirements of the maintenance unit. 

9.2.4.1 New Users  

• Access to the CMMS shall be controlled through a formal user registration 

process beginning with a formal request from unit heads to DPPI through HSS.  
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• Each user shall be identified by a unique user identification. Temporary 

password will be given to the user for which users are required to change 

password at first login.  

• To request access, a formal written request will be submitted to the DPPI 

through HSS.  

• Each user will be required to sign a compliance form to ensure a record of their 

access rights and that they understand the conditions of access and abide by 

the policy and procedures.  

• Passwords will be issued to the user upon submission of a filled and signed 

compliance form  

• A separate procedure will be in place for short-term accounts (including 

volunteers and students) are managed appropriately 

9.2.4.2 Change of User Requirements  

• Changed requirements will normally relate to an alteration to the modules used. 

Changed requirements must be requested by the unit head using the relevant 

electronic form which is available.  

9.2.4.3 Change of Password  

• All users will be required to change their password every 90 days. 

• Where a user has forgotten their password, the unit head is authorised to 

request a password reset to the systems administrator, provided the user 

already has access to the CMMS. Where access was not granted earlier, the 

users’ needs to complete a formal request. 

9.2.4.4 Removal of Users  

• As soon as a staff leaves his/her role for reason of resignation, retirement, 

severance, dismissal or any other legal cause, all logins must be revoked.  

• As part of the employee termination or transfer process to another facility, the 

maintenance head will have a notification from HSS. Once received s/he will 

disable the account. 



Page | 65  
 

9.2.4.5 review of user access rights  

• The CMMS administrator will institute a review of all access rights to the systems 

once a quarter which is designed to positively confirm all users.  

• Annually the CMMS administrator will institute a review of access to the CMMS. 

This will be done in co-operation with the unit heads and will be designed to 

positively re-confirm all users; all other logons will be deleted. In exceptional 

circumstances (including Maternity Leave) accounts which have not been used for 

some time will not be deleted but will continue to be monitored.   

The review will be conducted as follows: 

• The CMMS administrator will generate a list of all users and their access rights 

• The list will be sent to the unit heads/hospital management who will confirm that 

all users are authorised to still use the system 

• Any users who are no longer authorised to use the system will be removed from 

the system 

The Unit head will maintain records of: 

• Audits completed  

• System administrator responses  

• Actions taken  

9.2.5 Responsibilities  

End Users  

All users of CMMS must be made aware of the contents and implications of the user 

access management policy and the general requirement to ensure system security.  

Irresponsible or improper actions by users may result in disciplinary actions(s).  

End users must: 

• Keep their user details up-to-date, accurate and confidential. 

• Report to the unit head if a user considers they have inappropriate permissions or 

access. 
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• Ensure any requests for new user accounts or modification to access permissions 

are completed using the compliance forms which are sent to the unit head  

• Keeping their password secure and ensure it is neither disclosed to nor used by 

other parties, under any circumstances.  

• Only access the system using their own login and password.  All staff are 

accountable for any activity carried out under their login and password, and this is 

audited.  

• Notify their manager that their access rights should be changed and ensure that 

they do not continue to use access privileges from a previous role if a user changes 

their role. 

System Administrator  

The system administrator(s) must: 

• Ensure the production of all relevant operating procedures reflecting the 

requirements of this policy 

• Ensure all staff are aware of their responsibilities in line with this policy 

• Undertake review of access rights to the CMMS application and act on the results 

of these audits 

• Ensure records are accurate and kept up to date 

• Monitor and check compliance with this policy 

• Promote awareness and providing guidance on this policy 

Head of Maintenance 

The unit head must: 

• Ensure all staff are made aware of their security responsibilities as indicated in this 

policy 

• Ensure that all users under their management are given the appropriate access 

rights for their role 

 



Page | 67  
 

9.2.6 Training  

Training relating to this policy must take place during the induction programme for 

new staff or as part of refresher training at least every year  

9.2.7 Review  

This Policy will be reviewed after 3 years, or sooner, as required.  
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9.3.0 DATA PROTECTION POLICY 

9.3.1 Introduction 

The CMMS comprises of assets to the Hospital, HSS and MOHS. The assets include 

hardware devices, software, and data, essential to the effective and continuing 

operation of the maintenance unit.  

The data for and in this system is confidential and sensitive, and it is necessary for all 

information systems to be protected against any events, accidental or malicious, which 

may put at risk the data or the activities of unit and the hospital. 

This policy applies to all electronic and manual data collection systems used by 

maintenance unit. All staff are required to adhere to this policy. 

9.3.2 Policy Statement and scope 

• This policy describes the processes for improving and maintaining security of the 

CMMS. 

• Further,  

• This policy describes the processes to ensure that the hospital maintenance units 

comply with current statutory obligations and observes standards of good practice. 

• This policy describes the processes to minimise the risk of data security breach. 

9.3.3 Policy Overall 

DPPI-MOHS is committed to developing and maintaining CMMS infrastructure, which 

has an appropriate level of security and data protection.  All systems will have a 

minimum-security framework. 

CMMS is managed by Admin-Staff at facility level with support from DPPI - MOHS IT 

support team on behalf of HSS.  In the case of hospital maintenance unit, it is the 

responsibility of unit head to ensure compliance with this policy. 

Sharing of information with other organisations or individuals is subject to approval by 

hospital management and HSS.   
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Specifically, the principles require that data: 

• Shall be processed fairly and lawfully and shall not be shared unless specific 

conditions are met. 

• Shall be obtained only for one or more specified and lawful purposes and shall 

not be further processed in any manner incompatible with that purpose or those 

purposes. 

• Shall be adequate, relevant, and not excessive in relation to the purpose or 

purposes for which they are processed. 

• Shall be accurate and, where necessary, kept up to date. 

• Appropriate measures shall be taken against unauthorised or unlawful 

processing of data Therefore, Hospital maintenance unit will: 

• Observe fully conditions regarding the fair collection and use of information. 

• Meet its obligations to specify the purposes for which data is used. 

• Collect and process appropriate data, and only to the extent that it is needed 

to fulfil operational needs or to comply with any legal requirements. 

• Ensure the quality of data used. 

In addition, hospital maintenance units will ensure that: 

• There is someone with specific responsibility for data protection in the unit. 

• Everyone managing and handling personal information understands that they 

are contractually responsible for following good data protection practice. 

• Anybody wanting to make enquiries about handling personal information knows 

what to do. 

• Queries about handling personal information are promptly and courteously 

dealt with. 

• Methods of handling personal information are clearly described. 
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This concludes the current Data Protection Policy that hospital maintenance units have 

agreed to abide by. The information presented here does not constitute legal advice. 

For personal legal advice on this or other areas you should consult a solicitor. 
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9.4.0 RELATED DOCUMENT 

Proof for reading and understanding policies 

9.4.1 DOCUMENT ATTESTATION RECORDS 

I have read and understood the following document(s):  

NAME SIGNATURE DESIGNATION DATE 
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I have read and understood the following document(s):  

NAME SIGNATURE DESIGNATION DATE 

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

 

 

 


